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Metrics are used in nearly every business pro-

cess, including disaster preparedness and any 

business continuity plan (BCP) you might have at 

the ready. Businesses that are looking to ensure 

that their company will make it through any dis-

aster successfully need to have an effective BCP 

with metrics like RTO and RPO in place. 

 

While both RTO and RPO are important ele-

ments of continuity plans, and they both sound 

fairly similar, they are actually quite different. In 

this article we define RTO and RPO and take a 

look at what the difference is between the two 

concepts. 

 

RTO Defined 
 

RTO, or Recovery Time Objective, is the target 

time you set for the recovery of your IT and busi-

ness activities after a disaster has struck. The 

goal here is to calculate how quickly you need to 

recover, which can then dictate the type or prepa-

rations you need to implement and the overall 

budget you should assign to business continuity. 

If, for example, you find that your RTO is five 

hours, meaning your business can survive with 

systems down for this amount of time, then you 

will need to ensure a high level of preparation and 

a higher budget to ensure that systems can be re-

covered quickly. On the other hand, if the RTO is 

two weeks, then you can probably budget less and 

invest in less advanced solutions. 

 

RPO Defined 
 

RPO, or Recovery Point Objective, is focused on 

data and your company's loss tolerance in relation 

to your data. RPO is determined by looking at the 

time between data backups and the amount of data 

that could be lost in between backups. 

 

As part of business continuity planning, you need 

to figure out how long you can afford to operate 

without that data before the business suffers. A 

good example of setting an RPO is to imagine that 

you are writing an important, yet lengthy, report. 

Think to yourself that eventually your computer 

will crash and the content written after your last 

(Continued on page 2) 

Excel Headers and Footers 101 
Microsoft Excel has become an increasingly 

versatile work application catering to most busi-

nesses, big and small. While most users are fa-

miliar with all the functions the app has to offer, 

many are still unaware that you can add a head-

er or footer to your spreadsheets. With that in 

mind, it's time for a comprehensive view of what 

headers and footers are and how they work in 

Excel. 

 

What are headers and footers? 

 

As with Word, Headers and footers are lines of 

text that print at the top (header) and bottom 

(footer) of each page in an Excel spreadsheet. 

They often contain descriptive text such as titles, 

dates, or page numbers displayed in page layout 

views and on printed pages. 

Headers and footers are useful in providing 

(Continued on page 2) 
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Fun Facts about 

Elephants  
 

 

1. There are two types of 

elephants– African and 

Asian elephants. 

2. Elephants have an 

evolved 6th toe. 

3. Elephants don’t actually 

like peanuts and zoos 

don’t feed them to their 

captive elephants. 

4. African elephants are the 

largest land mammals on 

the planet. 

5. The elephant’s closest 

relative is the rock hyrax, 

a small furry mammal 

that lives in sub-Saharan 

Africa and the coast of the 

Arabian peninsula. 

6. Elephants can get 

sunburned so they throw 

sand on themselves for 

protection. 

7. Female elephants are 

pregnant for around 22 

months. 

8. An elephant’s skin is an 

inch thick. 
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save will be lost. How much time can you tolerate having to 

try to recover, or rewrite that missing content? 

 

That time becomes your RPO, and should become the indi-

cator of how often you back your data up, or in this case, 

save your work. If you find that your business can survive 

three to four days in between backups, then the RPO would 

be three days (the shortest time between backups). 

 

(Continued from page 1) 
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What's the main difference between RTO and RPO? 

 

The major difference between these two metrics is 

their purpose. The RTO is usually large scale, and 

looks at your whole business and systems involved. 

RPO focuses just on data and your company's overall 

resilience to the loss of it. 

 

If you are looking to improve or even set your RTO 

and RPO, contact us today! 

quick information about your document or data in a predict-

able format and also help set out different parts of a docu-

ment. Simply put, they make calculations, graphs, and pivot 

tables much easier to read and follow. 

 

How to Add and Remove Headers and Footers 
 

Select the spreadsheet for which you want to add headers or 

footers. On the Insert tab in the Text group, click Header & 

Footer; this displays the spreadsheet in page layout view. 

To add a header or footer, click on the left, right or center of 

the Header or Footer text box at the top or bottom of the 

spreadsheet page.  You can now add a preset header or foot-

er to your document, or create a custom header and footer. 

(Continued from page 1) 
To start a new line in a header or footer text box, press 

ENTER; to include a single ampersand (&) in the text of 

a header or footer, use two ampersands. When you are 

done, click anywhere in the spreadsheet to close Header 

or Footer. 

Return to Normal page view by clicking on the View tab 

and Normal button. 

 

To remove the header or footer from a spreadsheet, se-

lect the View tab and click on Page Layout. Delete the 

information you want to remove. 

 

The next time you need to repeat text on a page to make 

information more organized and easier to digest, you can 

simply do so with Excel's header and footer feature. 

Looking to learn more about Microsoft Office and its 

features? Contact us today and see how we can help. 

 

Published with permission from TechAdvisory.org. 

Excel Headers and Footers (cont.) 

Books that Feature Elephants 
 

For Children:  Books by Mo Willems; Modoc: the True Story of the Greatest Elephant that Ever Lived by Ralph 

Helfer; Babar books by Laurent de Brunhoff;  The Magician’s Elephant by Kate DiCamillo 

For Adults:  The Elephant Whisperer by Lawrence Anthony;  An Elephant in the Garden by Michael Morpurgo, Water 

for Elephants by Sara Gruen and many, many more!!! 
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Finding Apps on your iPad 
The app is arguably the most important part of the 

iPad. After all, it is the apps that give the device its 

unparalleled usability and features. A common issue 

many users come across is that they often have a large 

number of apps and it can be tough to figure out what 

apps you have installed, or even to find all of your 

apps. If you have had this problem before, here are 

three tips that can help. 

1. Finding installed apps via Settings 

While there is no set section of the iPad's Settings that 

allows you to view installed apps, you can actually 

view installed apps by looking at the Usage section. 

This section tells users how much storage space in-

stalled apps are using, therefore giving you a list of 

installed apps. 

You can access the Usage section of Settings by: 

1. Opening the Settings panel on your iPad. 

2. Tapping on General. 

3. Selecting Usage. 

This will list the apps you have installed, organized by 

how much hard drive space they are using. What's 

great about this method is that you can not only see the 

apps you have installed but also see if there are apps 

you aren't using, or apps that are taking up valuable 

space. You can also select apps to learn more about 

how much memory they are using and even uninstall 

an app should you not need it anymore. 

2. Finding installed apps via Spotlight 

If you have iOS 7 on your iPad you can view all in-

stalled apps via the Spotlight feature. Spotlight allows 

you to search your iPad for files, folders, apps, and 

more, and can be accessed by swiping down from the 

top of the screen when looking at the Home screen. 

You can see what apps you have installed using Spot-

light by: 

1. Opening Spotlight by sliding down from the 

top of your iPad's screen. 

2. Tapping on the blank spot beside the magni-

fying glass. 

3. Typing "." (period/full stop) without the quo-

tations. 

You should see a list of your installed apps come up, 

though there is no apparent way they are organized. If 

you tap on an app name, it will open. 

3. Finding installed apps via iTunes 

The other way you can find out the apps you have in-

stalled is via iTunes. You can do this by: 

1. Plugging your iPad into your computer via the 

cord that came with the device. 

2. Opening iTunes, if it doesn't open automatical-

ly when you connect it. 

3. Clicking on the device's name under Devices. 

4. Selecting Apps. 

You will be able to search for apps, or you should see a 

full list of installed apps. The great thing about this fea-

ture is that if you search for apps, you should see where 

they are on your device's screen. From there you can 

move the apps around, or even delete them. 

If you are looking to learn more about using the iPad, 

please contact us today to see how we can help. 

Published with permission from TechAdvisory.org. 

Source. 

 

 

  

Above:  Note Taker HD (left) and ArtRage (right) are 

two apps that made the Top 100 Apps for iPads 2014 

list by PC Magazine. 
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they are treated.  Because of the many wars that have rav-

aged and destroyed not just human communities but ele-

phant communities in Africa, many younger  African ele-

phants have shown typical symptoms of post-traumatic 

stress disorder (PTSD), violence and other asymptomatic 

behavior.  There have been some efforts by conservation-

ists, park rangers and even the elephants themselves to 

rebuild their communities.  In Kenya, the David Sheldrick 

Wildlife Trust is a sanctuary for orphaned and traumatized 

wild elephants where human caregivers serve as surrogate 

mothers.  To date, the Sheldrick Trust has rehabilitated 

more than 60 elephants and reintroduced them to wild 

herds.  

 

In the United States, the Elephant Sanctuary in Tennessee 

has made its mission to help emotionally and psychological-

ly disturbed former zoo and circus elephants where they are 

treated  and rehabilitated with the “passive control” system, 

a therapy also used with human PTSD cases.   For abused 

elephants in Asia, there are  sanctuaries in India and parts 

of Asia such as Thailand.  Many sanctuaries have elephant 

cams which are fun to watch online. 

 

Most efforts by elephant sanctuaries have been successful 

but there is still much to be done for those elephants in dan-

ger from circuses, wars, street living and more.   

 

To find out more, visit the following websites: 

 

The Elephant Sanctuary (Tennessee):   

www.elephants.com 

 

The David Sheldrick Wildlife Trust (Kenya):  

www.sheldrickwildlifetrust.org 

Inquiring Minds... 

Elephant Appreciation Day 

 

Elephant Appreciation Day is September 22!  Draw some 

elephant pictures or watch some elephants draw in honor 

of these gentle giants.  Go to the zoo or visit You Tube and 

watch elephants at play.  Elephants in captivity have been 

known to form special bonds with other animals such as 

Bubbles, a 32 year old African elephant, whose best friend 

is Bella, a 3 year old Labrador, both of whom live together 

at the Myrtle Beach Safari in South Carolina.  Elephants 

are very social, gregarious and gentle animals by nature.   

 

Elephant Communities in Jeopardy 

 

Many elephants suffer due to their environment or how 

 

    

The question is, are we happy 

to suppose that our grandchil-

dren may never be able to see 

an elephant except in a picture 

book? 

 

- David Attenborough 

Make all of my computer problems go away 

without the cost of a  full-time I.T. staff 

Ask us about our fixed price service agreements and kick off the 

new year with computer support at a flat monthly fee  you can 

budget for just like rent! 

Our printed newsletters are always available 
online!  Check it out at www.AXICOM.net. 
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